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Advanced FAQ for SMART Board Software for
Windows Operating Systems 
What are some of the features of the newest releases of SMART Board software?
The newest release of SMART Board software has identical functionality as the previous release as well as some
new features, including: 

• Support for SMART Board software for Windows operating systems in eleven languages: English, French,
Spanish, German, Norwegian, Japanese, Chinese Traditional, Chinese Simplified, Korean, Portuguese,
Welsh and Italian

• SMART Ideas software – SMART Board Interactive Whiteboard version
• Clip Art
• SMART Video Player
• Advanced integration with Microsoft Word and Excel applications
• Templates in Notebook software
• New On-Screen display controls

How can I use the SMART Video Player? 
Use SMART Video Player to annotate over moving or still video from VCRs, document cameras and computer files.
You can write over top of your video presentation, as well as play or freeze frames and save or clear your
annotations. When you save your annotation, it’s automatically sent as a screen capture to SMART Notebook
software. 

If you like, enable the Pause When Tool(s) Lifted setting to automatically pause a video when you pick up a stylus
from the SMART Pen Tray. You can also use this feature when you’re viewing computer video files, such as AVI
files, playing or pausing the presentation at any point to write over it (and then, if you like, saving the annotation).

Do I need any special equipment or software to use the SMART Video Player?
Any video that you can view in Windows Media Player is supported by SMART Video Player. 

NOTE: SMART Video Player will not run on Windows 95, 98 or Windows NT4.0 operating systems.

To use SMART Video Player, you’ll need:
• A Windows 98 SE, ME, 2000 or XP operating system
• Windows Media Player 
• DirectX-compatible video hardware that complies with the DirectX application programming interface, 

for example, ATI All-in-Wonder Radeon, Marvel G450 eTV (Matrox PC), ATI TV Wonder (USB edition),
WinTV USB edition, or D-Link (a USB Video-Capture Device)

• a computer that supports the DirectX application programming interface 
NOTE: SMART Video Player does not support internal DVD drives, MOV files or live video streamed over the
Internet.

What are the optimal system parameters for running the SMART Video Player?
As long as your computer meets the requirements for SMART Board software, you can use SMART Video Player.
However, for best performance we recommend your computer meet the following standards:

 Pentium III brand 800-MHz or higher processor
 128 MB RAM
 200 MB of free hard disk space
 DirectX-compatible video card
 DirectX application programming interface support
 Windows 98 SE, 2000, ME or XP operating system
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What differences will I see in the way Microsoft Word and Excel software work on a
SMART Board interactive whiteboard?
We’ve enhanced the SMART Board driver so that Microsoft Word and Excel software behave as board-aware
applications on the interactive whiteboard. This means that whatever you write or draw with a Pen Tray stylus may
become a component of the Word or Excel file rather than an external annotation. In other words, you can save
what you write within the program itself.  

Now you can take even more advantage of the large interactive whiteboard surface to work on Word documents or
Excel spreadsheets with your group by saving your annotation in converted-to-text form or as freeform drawing
objects. 

With both the Microsoft Word or Excel program and SMART Board tools running, lift up a Pen Tray stylus. The
following Capture/Save toolbar will appear: 

Press   to save the annotation in its current form. It will appear as a drawing object inside a frame, which you
can easily move elsewhere within the document or delete.

Press  to convert the annotation to text and insert it at the cursor point. 

NOTE: Microsoft Word program must be in Page Layout view to capture your annotations. 

Can I write over Microsoft Word or Excel files without saving my annotations into the
documents/spreadsheets?
If you prefer, you can continue to work with Word or Excel software as you always have on your interactive
whiteboard. 

You have the choice of disabling SMART Aware in the SMART Board Control Panel, disabling the board-aware
status of either or both programs in the Aware interface, or simply ignoring the capture tool buttons that appear
when you lift a stylus.

Of course, if you prefer to save your annotations without altering your Word or Excel file, you can always capture
them into Notebook software, just as you did in previous versions of SMART Board software. To do this, use the
capture buttons in the Capture/Save toolbar that appears when you lift a stylus.

Apart from Microsoft Word and Excel software, are there any other new board-aware
applications?
We’ve also added Volo View Express and AutoVue Professional software to the list of board-aware applications.
These programs let you view and annotate AutoCAD software, even if you don’t have AutoCAD software installed
on your system. Both programs store your interactive whiteboard annotations in a separate markup file, thereby
preserving the integrity of the original drawing. Whenever you want, you can open or close your markup file without
affecting the underlying drawing. Note that Microsoft Imaging for Windows software is now board-aware as well.

Press to inject
annotation as text

Press  to insert
annotation as-is
(freeform graphical
object)

Capture region
into Notebook

Capture screen
into Notebook
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Does the Microsoft PowerPoint program still work the same way on an interactive
whiteboard?
If you’re accustomed to running PowerPoint program presentations on the interactive whiteboard, you won’t notice
any substantial differences in behavior. However, we’ve added a new setting that makes presenting on the
interactive whiteboard even easier. Use the Auto-Save Annotations on Advance setting to automatically save
annotations into the PowerPoint presentation when you move to the next slide. While this setting spares you the
bother of selecting Save to PowerPoint prior to each slide advance, you still have the option of saving your
annotations on selected slides only, or saving annotations into Notebook software.

We’ve also added commands to:

 directly access the SMART Floating Tools (SMART Floating Tools)
 hide/reveal the current slide (Black/Unblack)

 go directly to any slide in the sequence (Go to Slide)

How do Notebook software templates work?
The idea behind templates is that while you may create many documents, you generally create only a few types of
documents. Templates provide a place to store boilerplate symbols and notes, reducing the amount of work
necessary to set up new documents. 

Preserve your commonly used Notebook page layouts by saving any Notebook file as a template file. You can then
open this template file, select a template page and insert it anywhere within your current file. 

Select the Save as Template command in the File menu to save the current Notebook file as a template file. Open
another Notebook file and select either the Current Template or Select Template command in the Insert menu.
These commands are also available from the Templates button ( )in the Standard toolbar.  

A page-sorter view of the template file will open, and you can select a specific page from the template file to insert
into the current file.
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Are there any changes to the Notebook interface?
While you won’t see any major changes to the Notebook software, you may notice a number of minor
improvements to the interface.

In an effort to streamline the Notebook software menus, the Tools menu has been removed and the commands
that were previously available from that menu have been relocated: 

 Notebook software’s popular Screen Capture toolbar command has been relocated from the Tools to the
View menu. In addition, you can now launch the Screen Capture toolbar by selecting . This button is
available from both the Simple and the Standard toolbar.

 The Spell Check command has been relocated from the Tools to the Edit menu. 

Several Windows toolbar buttons have undergone minor renovation with this version of SMART Board software:

The appearance of the Next and Previous Page toolbar buttons have been improved:

 To move to the next page in a Notebook file, press .

 To move to the previous page in a Notebook file, press .

The Current Color, Line Width and Fill buttons now appear as follows:

The Full Screen button (on the right side of the Status bar) has also been revised:

You can also save your Notebook file in Mac OS X and UNIX form. The new command Save as Mac OSX/UNIX
Notebook file is available in the File menu.

Does handwriting recognition work differently with the newest version of SMART Board
software?
We’ve made it easier to inject converted handwriting into an application that is not board-aware. When you
annotate over a non-board-aware application, you have the option of injecting your handwritten text into the
underlying application in typed-text form. 

Just press and hold on the annotation for about three seconds. The following shortcut menu appears:

Press Inject “what you wrote” Here and a text version of your annotation will appear at the cursor-insertion point
in the underlying program.

NOTE: If you just tap the interactive whiteboard or press it briefly, the annotation will disappear. We recommend
you practice inserting text once or twice so you can easily introduce annotations into the text of non-board-aware
programs. Remember, to inject text, you need to use a prolonged press on the annotation rather than a tap.

If you prefer, you can still use the handwriting recognition feature in the On-Screen Keyboard. Just press the Write
button in the On-Screen Keyboard, and then write in the Writing Recognition box with your finger or a stylus.

Current Color
Line Width

Fill
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What’s an on-screen projector controller?
If you're using your SMART Board interactive whiteboard with a projector, you'll probably want to configure an On-
Screen Display Controller. That way, you can control your projector at the interactive whiteboard surface, and
protect your equipment by automatically turning off the projector bulb or PDP during periods of inactivity. Putting
the PDP into standby mode during periods of inactivity prevents image burn-in.

You’ll never need to hunt for your projector’s elusive remote control again. The On-Screen Display Controller offers you
the convenience of controlling your projector as you would with your projector’s remote control – right at the interactive
whiteboard surface. And, unlike the remote control, the on-screen controller is no further away than a finger-press on
the On-Screen Display Controller icon in the System Tray.

Specific on-screen controls vary according to the display-device model, but, in general, standby, volume and input
mode controls are all accessible from the interactive whiteboard. Here’s an example of an On-Screen Controller dialog
box (for a Sony projector):

NOTE: In order to use an On-Screen Display Controller, you’ll need to connect a DB9-to-DB9 RS-232 serial cable (or
the mini-DIN8-to-DB9 serial cable supplied with your projector) from the serial port of your display device to a serial
port on your computer.

How do I set up an On-Screen Projector Controller to use with my projector?
The Display Controller wizard in SMART Board software makes it very easy to configure an On-Screen Projector
Controller.

The first step is to connect a DB9-to-DB9 RS-232 serial cable (or the mini-DIN8-to-DB9 serial cable supplied with
your projector) from the serial port of your display device to a serial port on your computer.

Next, access the Display Controller wizard. Press the SMART Board icon in the system tray and select Control
Panel. Press the Advanced button and select On-Screen Controller Settings. The Control Panel will open at the
Display Controllers tab. Now press the Add button and the On-Screen Controller Wizard will appear.

This wizard will guide you through the simple process of selecting:

• the serial port to which you connected the projector’s serial cable

• the manufacturer and model of your projector

That’s it. As soon as you’re finished, the On-Screen Controller icon will appear in your system tray and you can
start controlling your projector from the on-screen interface.
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What benefits do the Floating Tools provide?
To open the Floating Tools, click the SMART Board system tray icon and then click on the Floating Tools button. In
addition to the virtual Pen Tray tools (the pen, highlighter and eraser), the Floating Tools offers features that have
no Pen Tray counterpart: Tools for creating geometric shapes or a right-mouse click, capturing your annotations,
clearing annotations and restoring cleared annotations. 

One of these Floating Tools buttons that deserves special mention is the Restore/Clear Annotations button. When
annotations are on the interactive whiteboard, the button is in its Clear Annotations state; As soon as an annotation
is deleted, the button changes to Restore Annotations state.

You may write an important note on the interactive whiteboard and then touch the interactive whiteboard
accidentally: That annotation will disappear. However, if you press the Restore Annotations button your note will be
reappear on the interactive whiteboard, restored exactly to its original state. 

If you don't have the Floating Tools open when you lose an annotation – don't panic. Press on the SMART Board
tools system tray icon, select Floating Tools and then press the Restore Annotations button. The last cleared
annotation will be restored to view.

Another particular favorite of interactive whiteboard presenters is the Screen Pointer button, which turns the next
interactive whiteboard contact into a large, floating pointer mouse – an ideal tool for focusing the attention of your
audience where you want.

Just press on the Screen Pointer tool and a large arrow will appear on the screen. Press and drag it anywhere on
the SMART Board interactive whiteboard. You can easily change the arrow's direction too: press once on the
arrow and red directional arrows will appear. With each subsequent press you'll rotate the arrow 90°. To get rid of
the arrow, just double-press on it.

The Transparent Rectangle button is another very handy way of directing the attention of your audience. Use it to
highlight large blocks of information on the interactive whiteboard. Press the Transparent Rectangle button and
then press and drag to outline any area of text or graphics.

Can I add tool buttons to the Floating Tools?
The number of tools available for the Floating Tools has been greatly expanded. You can customize the default
Floating Tools palette to contain as many as 20 tool buttons. You'll find all 20 described in the online Help for
SMART Board tools and in an appendix of the SMART Board User's Guide. You can also change individual tools.

To add buttons to the Floating Tools:

1 Open the SMART Board Control Panel.

2 Click the Floating Tools tab.

3 Drag individual tools from the List of Tools onto the Editable Floating Tool Bar.
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Can I save my reconfigured Floating Tools so they won't be changed by anybody else?
You may want to save the changes you've made to either the Pen Tray tools or the Floating Tools in the form of a
user profile for each tool set. This profile can be saved and then opened when you next use the SMART Board
interactive whiteboard. 

This means that you never need to reset tools because other users have altered the settings. In this way, multiple
users of the same SMART Board interactive whiteboard, all with different tool needs and preferences, can tailor
the Pen Tray tools for their own purposes and never have to repeat the configuration procedure. 

To save your tools settings as a user profile:

1 Edit the Pen Tray tools or Floating Tools as described above.

2 Click the drop-down arrow in the User Profiles text box.

3 Select Save As.

The New Profile dialog box appears. Follow the remaining on-screen instructions.

Can I use my Floating Tools User Profile on a different SMART Board interactive
whiteboard?
Your user profile is very portable. Each user profile is stored as an STLS file in the SMART Board software
directory on your hard drive (wherever you installed the software initially). 

If you want to move a profile from one computer to another, you can either move the STLS file to a shared network
directory, or copy it onto a floppy disk and transfer it physically from your floppy drive to the floppy drive on the
destination computer. At this point, you'll need to copy the STLS file into the destination computer's SMART Board
software directory.

If you want to make your user profile more secure, you can make the STLS file read-only in the same way you
change the security properties of any Windows file. Right-mouse click on the STLS file in your Explorer view, click
on Properties, and then click on Read-only under Attributes. 
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